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keyboardFX v1.51 - user guide



description

keyboardFX is a specialized tool for Adobe After Effects that enables the cre-
ation of fully customizable keyboards along with user-defined typing animations.

Simply input your text, and keyboardFX will generate a graphical keyboard
within the composition, automatically assigning all necessary expressions to
the layers. It synchronizes the illumination of keys with the typing of your text.
Beyond alphanumeric keys, keyboardFX also supports the illumination of the
Function, Modifier, Arrow, Navigation and Numeric Keypad keys.

Installation

keyboardFX can be run as a dockable panel or as a window.

To install and run as a dockable panel (will be visible in the "Window" menu):
1. Copy the file keyboardFX.jsxbin into the folder:

".Support Files/Scripts/Script Ul Panels” (on Windows)

or ".Scripts/Script Ul Panels” (on MacOS) of your After Effects installation.
2. Restart After Effects

To install and run as a window (will be visible in the File -> Scripts Menu):
1. Copy the file keyboardFXjsxbininto the folder:

".Support Files/Scripts/” (on Windows)

or ".Scripts/" (on OS X) of your After Effects installation.
2. Restart After Effects
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The script can be run as a dockable panel (will be visible and run from the
: “Window" menu of After Effects) or in “window mode” (visible and run
| ﬂtem‘:a Ce 1/3 from the File -> Scripts menu). The mode depends on which folder you in-
stall the script in (see instructions on page 2)

Opens the Virtual Keyboard panel.
Here you can insert the special codes
for illuminating Function, Modifier,
Arrow, Navigation & Numeric Keypad,
fast and easy

Clicking on the logo brings up
a window with small help tips.

Here we will also find a\_
list of special codes for e
illuminating the mm FX( T
modifier (CTRL, SHIFT etc)

cursor @rrow keys)

navigation (Page Up/Down etc)

bet made satting:

and numneric pad = Ea Besides the custom text,
keys of a keyboard there are five presets
custom text = for generating interesting
\ lighting key animations:
_sequentially horizontal
Hello World'{{PAGE DOWN}} _sequentially vertical
Here you can type the custom _random
text that keyboardFX will _ Spira|_in
generate typing animations for. _ spiral-out

Please refer to pages 5-8
on this guide for more
information on how to
illuminate special keys.

Starts the generation procedure
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nterface 2/3

Speed Slider Mode: In this mode, the typing speed of the generated
text is controlled from the “Type Speed” effect control. This controls
the speed of the typing animation as a whole.

Comp1 - keyboardFX - keys
¥ fx TypeSpeed
» 1) Slider

keyboard|.(

@ :speed slider

all keystrokes are evenly spaced-out in the
timeline and the typing speed is adjusted by the
'"Type Speed' effect control slider

@ using markers | markers distance:

every keystroke is linked to a marker on the
timeline. You can individually adjust the timing
of each keystroke by moving its marker

» M & Effect Controls keyboardFX - keys

Reset
15,00

Using Markers Mode: In this mode every character of the generated text is assigned to a named marker on
the timeline. There is no “Type Speed” slider. You can presicely time your typing animation by moving each

marker.
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You can select between 7 basic
types of keyboards.

Keep in mind that all keyboards are
highly customizable with a lot of
effect controls.

The 7 basic types of keyboards are:

Apple - Dark __

Apple - Light __

PC - Dark __

PC - Classic 2-Color Beige __
Mobile/Tablet Dark __
Mobile/Tablet Light __
Commodore 64 __

select between a
QWERTY, AZERTY or DVORAK
keyboard layout

keyboard| {

keyboard:  Apple - Dark

Enables the 3D switch for
all layers that keyboardFX
creates and applies a
small extrusion to the
keys and backplate of the
keyboard

Enable the 3D switch
Create text layers for each key

creates separate text
layers for each key.
keyboardFX uses the
Arial font by default

Shy the key text layers

Enable the progress bar
keyboard layout

@ Qwerty O Azerty QO Dvorak
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enables the shy switch
for all the key text layers

enables/disables the
progress bar




special codes

A keyboard, apart from the CHARACTER keys, also features a lot of extra keys.
These typically are:

The FUNCTION keys: F1, F2 ... F12 etc.

The MODIFIER keys: ALT, CTRL, SHIFT, MENU etc.

The ARROW keys: t — | —

The NAVIGATION keys: INSERT, DELETE, HOME, END, PAGE UP etc.

The NUMERIC KEYPAD keys: 0....9, NUM LOCK, SLASH, ASTERISK, MINUS SIGN, ENTER etc.

_ In order for keyboardFX to understand -on a string of

text- that you want these keys to be illuminated,
keyboard Fx( EpRy a special code must be typed. This special code is

nothing more than double curly brackets before and
— ' after the special key you want to illuminate, like this:
custom text o {{SPECIAL KEY}}

Hello World {{PAGE DOWN}} For example:

You want keyboardFX to generate typing animations
for the following two words: Hello World! and imme-
diately after that, you want to illuminate the “Page
Down” key. What you should type in the text field of
keybardFX is: Hello World!{{PAGE DOWN}} and then
press the “Generate Keyboard!” button.

To make this process easier, we created a con- |
venient virtual keyboard where you can insert
the special codes -required for illuminating
Function, Modifier. Arrow, Navigation & Nu-
meric Keypad keys- into your text, by just click-
ing their corresponding buttons on the panel. oL o ackess the VirLall ey baaralandl by Clicking this icor MR o keyboardEXS Ul

(If you don't want to use the Virtual Keyboard for entering special codes and want to type them
manually, the following pages contain detailed lists of all the codes, for every available keyboard)
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special codes - Apple

delete:

tab:

caps lock:
return:

left shift:

right shift:

left contral:
left option:
left command:
spacebar:
right command:
right option:
right control:

Escape: {{ESCH
F1: {{F1}}
F2: {{F2}3}
F3: {F3}}
F4. {{F4}}
F5: {{F51
F6: {{F6}}
F7: {{F71}
F8: {{F8}}
Fo: {{Fon

F10: {{F10}}
F11: {{F11}
F12: {{F12}}
A : {{EJECT}}

{{DELETE}}

{TAB}}

{{CAPS LOCK}}
{{RETURN}}

{{LEFT SHIFT}}
{{RIGHT SHIFT}}
{{LEFT CONTROL}}
{{LEFT OPTION}}
{{LEFT COMMAND}}

{{SPACEBAR}} (optional)
{{RIGHT ACOMMAND}}

{{RIGHT OPTION}}
{{RIGHT CONTROL}}

F13:
F14:
Fil5:
F16:
F17:
F18:
F19:

{{F13}}
{{F14}}
{{F15}}
{{F16}}
{F17}}
{{F18}}
{{F193}

arrow up: {{ARROW UP}} /

fr: {{FUNCTION}}
home: {{HOME}}
page Up: {{PAGE UP}}
delete: {{NAV DELETE}}
end: {{END}}
page down: {{PAGE DOWN}}

i
donan

clear: {{NUM CLEAR}}
= {{NUM EQUAL}}
- {{NUM SLASH}}

arrow left: {{ARROW LEFT}}
arrow down: {{ARROW DOWN}}
arrow right: {{ARROW RIGHT}}
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* . {{NUM ASTERISK}}
7 {{NUM 73}
8 {{NUM 8}}
- {{NUM 9}}
- - {{NUM MINUS}}
- {{NUM 4}}
- {{NUM 5}}
- {{NUM 6}}
- {{NUM PLUS}H}
- {{NUM 1}}
- {{NUM 2}}
- {{NUM 3}}
- {{NUM 0}}
+ - {{NUM FULL STOP}}
enter: {{NUM ENTER}}
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special codes - PC

Numbers Lock: {{NUM LOCK}}
Slash: {{NUM SLASH}}
Asterisk: {{NUM ASTERISK}}
Minus Sign/Dash: {NUM MINUS}}

Escape: {{ESCH Seven: {{NUM 73}
F1. {F1}} Eight: {{NUM 8}}
F2: {{F21} Insert: {{INSERT}} Nine: {NUM 9}}
F3: {{F31} Home: {(HOME} Plus Sign: {{NUM PLUS}}
F4: {{F4}} Page Up: [{PAGE UP}} Four: {{NUM 4}}
F5: {{F5h Delete: {{NAV DELETE}} Five: {{NUM 5}
F6: {{Fe}} End: {END}) Six: {{NUM 6}}
F7. (7 Page Down: {{PAGE DOWN}} One: {{NUM 1}
F&: {{F8}} Two: {{NUM 233
Fo: {{FO}} Print Screen:{{PRINT SCREEN}} Three: {NUM 3}}
F10: {{F10} Scroll Lock {{SCROLL LOCK3}} Zero: {{NUM 0}}
F11: {{F11}) Pause/Break {{PAUSE BREAK}} Full Stop: {{NUM FULL STOP}}
F12: {{F12}3 Enter: {{NUM ENTER}}
‘B B0 B 'R R R B R R R §BOEaAARR —
e B RN EEN EEE BN e gyl [N ! ! foew B e N
Backspace: {{BACKSPACE}} Arrow Up: {{ARROW UP}}
Tab: {TAB}} Arrow Left: {{ARROW LEFT}}
Caps Lock: {{CAPS LOCK}H Arrow Down: {{ARROW DOWN}}
Enter: {{ENTER}} Arrow Right: {{ARROW RIGHT}}

Left shift: {{LEFT SHIFT}}
Right shift: {{RIGHT SHIFT}}
Left Control: {{LEFT CONTROL}}
Left Windows: {{LEFT WINDOWS}}
Left Alt: {{LEFT ALT}}
Spacebar: {SPACEBAR}} (cptional)
Right Alt: {{RIGHT ALT}}
Right Windows: {{RIGHT WINDOWS}}
Menu: {{MENU}}
Right Control: {{RIGHT CONTROL}}
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special codes - maobile/tablet

*

In this specific keyboard, keyboardFX
1 2 3 4 5 6 7 B 9 0 automatically inserts any {{SHIFT}}

codes in between your text when a

lower/upper change occurs, so there is
C) A EEd BRI B S B EEE R not need to do it manually.

Shift: {{SHIFT}} AN BEN FDE BB B BHE B R B

2123 @ o Backspace: {{BACKSPACE}}

Symbols: {{SYMBOLS}

Eriiafis: {5 Return: {{(RETURN}}

special codes - Commodoret4

Clear/Home: {{CLEAR HOME}}
Instert/Delete: {{INSTERT DELETE}}

Backspace: {{BACKSPACE}} F1: {{F1}}
Control: {{CONTROL}} Arrow Up: {{ARROW UP}} F3: {F3}}
Run/Stop: {{RUN STOP}} Restore: {{RESTORE}) F5: {{F5}}
Shift Lock: {{SHIFT LOCK}} Return: {{RETURN}) F7. {F73}
Commodare Key: {{COMMODORE}} Right Swift: {{RIGHT SHIFT}}
Left shift: {{LEFT SWIFT}} Cursor Up/Down: {{CURSOR UP DOWN}}
Space: {{SPACEBAR}} (optional) Cursor Left/Right: {{CURSOR LEFT RIGHT}}
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nause/hold

Apart from special codes for each keyboard there are also two extra codes that apply to every keyboard
that keyboardFX generates.

PAUSE

The {{PAUSE}} code. This code pauses the animation of the keys for a brief moment. The duration of a
single PAUSE is one keystroke. You can prolong the duration of a PAUSE for more than one keystroke by
putting a number after the HOLD code. You can enter {{PAUSE1}}. . . up to {{PAUSE30}.

For example if you enter the following text in keyboardFX text field:

This takes a long {{PAUSE10}} time!

The typing of the text will begin, then just after typing the word “long”, it will pause for a few moments
and then continue typing the rest of the given text.

HOLD
The {{HOLD}} code. This code prolongs the duration of the illumination of a key by one keystroke.
For example if you enter the following text in the keyboardFX text field:

Let's see a key combination!{{LEFT CONTROLIH{{HOLD3}} {{RIGHT ALT}H}{{HOLD2}{{NAY
DELETE}{{HOLD1}}

The typing of the text will begin. The Left Control key is going to illuminate, then while it stays illuminat-
ed the Right Alt key is going to light up, and while both of these keys stay illuminated the Nav Delete
key is also going to light up. When all three light up completely, then they all going to turn off simultane-
ously.

The duration of a single HOLD is one keystroke. You can prolong the illumination of a key for more than
one keystroke by putting a number after the HOLD code. So you can enter {{HOLD1}}...up to {{HOLD30}}

You can use the {{HOLD}} command to show key combinations, even light up complete rows or sections
of a keyboard.

NOTE: The HOLD command works only in the “Speed Slider” mode.
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effect controls

effect controls for adjusting
the typing speed and the
pre-run time

—

effect controls for adjusting
the roundness size, spacing, color
and glow properties of the keys

effect controls for adjusting
the color, size, position, track-
ing and line spacing of the text

layers for each key /

effect controls for adjusting
the look of the backplate /

effect control for adjusting
the cursor blinking rate

—
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Once the keyboard has been generated, you will find a number of the following
effect controls in the effect panel of the shape layer of keyboardFX.

B Effect Controls keyboardFX - keys

Comp 1 - keyboardFX - keys
¥ [ TypeSpeed
» [ Slider
¥ fx Pre Run
» ) Slider
L ] ﬁ( [ KEYS ) roundness
* 3 Slicer
¥ fx [ KEYS ): size
= ) Sligder ]
¥ fx [ KEYS): size X Reset
= [ Slider
¥ fx [KEYS):size ¥
e 5 Slider
¥ fix [ KEYS ): horizontal spacing
» 3 Slider
¥ fx [ KEYS ]: vertical spacing
= 1) Slider
¥ fx [ KEYS ]: fill color
) Color
¥ fx [ KEYS ]: stroke color
) Color
¥ i [ KEYS ]: stroke width
= 3 Slider
¥ fx [ KEYS ): outer stroke color
0 Color
¥ [ [ KEYS ) outer stroke width
» [ Slider
¥ fx [KEYS ]: pressed color
) Color
¥ fi [ KEYS ) glow intensity
» ) Slider
¥ f [ KEYS ]: glow size
= ) Slider
¥ o [ KEYS ): glow decay
» [ Slider
¥ fx [ KEYS ): glow stroke only e
) Checkbo O
¥ fic [ KEY TEXT ]: color
) Color
¥ fx [ KEY TEXT |: size
e [ Slider
¥ [ [ KEY TEXT ]: position offset
) Paint
¥ fx [KEY TEXT ]: tracking
e ) Slider
¥ i [ KEY TEXT J: line spacing
» 73 Slider
¥ f [ BACKPLATE ]: size
» ) Slider
¥ [ [ BACKPLATE }: roundness
» [ Slider
¥ fx [ BACKPLATE [ fill color
) Color
¥ fi [ BACKPLATE ] stroke color
O Color
v [ [ BACKPLATE | stroke width
= ) Slider
¥ [ [ CURSOR ]: blink rate
» [ Slider



compatibility

keyboardFX is compatible and has been successfully tested on:

- After Effects CS6

- After Effects CC

- After Effects CC 2014
- After Effects CC 2015
- After Effects CC 2015.3
- After Effects CC 2017
- After Effects CC 2018
- After Effects CC 2019
- After Effects 2020

- After Effects 2021

- After Effects 2022

- After Effects 2023

- After Effects 2024

on both Windows and Mac OS platforms.

trial l[imitations

You can test keyboardFX free for 7 days. In trial mode these limitations
apply:

- 15% of the total keys of the keyboard will not be available
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VEersion nistory

1.51 September 16, 2024

- fixed: an issue where in some AE installations keyboardFX would freeze on setting-up expressions
- fixed: an issue where keyboardFX would not set the Arial Font name properly for the generated text layers

1.5 September 2, 2024

- updated: the license framewaork

- gptimized: significant overall speed improvements in generating any type of keyboard

- fixed: a few annoying bugs

- updated: some special codes and also added a few more

- added: a Virtual Keyboard to easily input special codes for each type of keyboard

- added: numbers [0-9] on the mobile/tablet keyboard

- added: lower/case letters on the mobile/tablet keyboard

- gptimized: the maobile/tablet keyboard now automatically reads your text and inserts {{SHIFT}} codes on every lower/upper case change,
updating the keyboard keys as well

1.2 November 28th, 2019

- fixed: a bug which prevented the complete generation of Commodore64 keyboards on AE £S6

- fixed: the random preset for Commaodore64 was nat random. It's now fixed.

- fixed: a few typing errors on some of the presets

- fixed: a bug where the custom input text field was locked on first run on AE €S6

- fixed: carriage returns no longer mess the timing of the animations and properly light up the "Enter” key

- fixed: the order of the layers became shuffled, if there were gther existing layers in the timeline. It's now fixed.

- fixed: some layer properties stayed open in the timeline after the generation of the keyhoard. It's now fixed and every property is closed twirled up)

- changed: the glow and key layers are no longer locked
- changed: renamed the effect control "Glow Decay" to "Glow Decay Speed” for better clarity
- changed: smaller Ul + a few cosmetic changes

- optimized: before generating any keyboard, keyboardFX checks the input text and informs the user about mistyped special codes
- optimized: when deleting keyboardFX layers, expression efrors are now suppressed
- optimized: the -initial- typing speed and glow decay speed is automatically adjusted at a comfortable pace of approximately 8 characters per second
- optimized: redesigned progress bar that is more accurate, more informative, and works both in window and in dockable panel mode.
Also added a enable/disable checkbox for it, in the settings tab (CS6 only)
- optimized: compatibility with macOS Catalina
- optimized: instead of typing multiple {{PAUSE}} codes to further prolong a pause you can now type {PAUSE1}} through {{PAUSE30}}
{the same applies with the HOLD code)

- added: the {{HOLD}} special code which allows the illumination of key combinations (like Ctrl+Alt+Del)
- added: 3 second mode of controlling the keystroke animations through markers {(Using Markers Mode)
1.1 January Sth, 2019
- added: the DVORAK keyhoard layout
- added: five keys lighting animation pressts
- optimized: broadensd compatihility. keyboardFX in now compatible with older versions of After Effects (CC + C56)
- changed: keyboardFX no longer uses the "Arial” font as the default font for every text layer it generates.
It will now use what ever font is selected in theAfter Effects Character Panel upon generation.

1.0 October 28th, 2018

- initial release
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This script is provided "as is,” without warranty of any kind, expressed or implied.
In No event shall the author be held liable for any damages arising in any way from
the use of keyboardFX.




